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Introduction

The Pulse Recorder and Analyser (PRA) application uses computer's sound adaptor to analyse in 
real time signal received from different detectors, as Geiger counters, proportional gas counters, 
scintillation counters, semiconductor detectors etc. By using this software you can convert your 
computer in multi channel analyser (MCA), scaler, or simple counter, without buying expensive 
specialised hardware. Obviously, there are some limitations to the functionality of such instrument, 
mainly because of sampling rate usually limited to 48000 samples/s. However, if counting rate is 
reasonably low (less than 1000 pulses/s), the results are very good. PRA was designed for use in 
experiments with weak radioactive sources which are common in teaching laboratories. 

Changes in version 12.0.0

1. Added: Some space after last bin displayed in histograms to improve visual experience.

2. Changed: Changed nomenclature to more generalised (energy to quantity) and less 
ambiguous (frequency to counts). This change makes version 12 not fully compatible with 
previous versions (slightly changed settings format) but you can still open documents 
produced in versions 10 and 11 by loading data from the file rather then open the file. Then 
you can adjust the settings and save the file in a version 12 format.

3. Fixed: All known bugs.

Requirements

PRA can run on any computer with sound adaptor and WindowsXP or higher installed as a main or 
a virtual (using VMware or similar virtualisation software on Linux or Macintosh) operating 
system. It also runs on Linux boxes under Wine but it depends on how well your audio hardware is 
supported by Linux. It was tested with Lubuntu 16.04 and Wine 1.7.50 on my computer. PRA needs
≈600 MB of RAM to store maximum of 10000000 pulses in each channel.

Installation

PRA does not need any special installation, just copy “PRA.exe” and “PRA.pdf” files to folder of 
your choice and run the application. It is purely portable application and can be run from any 
location. Sometimes you may need administrator rights to install PRA in some special Windows 
folders as for example: “Program Files”. For convenience you can make link to PRA on your 
desktop or in the Windows menu, but you will be responsible to remove it if you decide uninstall 
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the program. To uninstall PRA simply delete “PRA.exe”, “PRA.pdf”, and “PRA.ini” files. The PRA
program itself does not write any information to the Windows Registry. PRA comes in two versions:
32 bits and 64 bits. The 64 bits version works only on 64 bits operating system. The 32 bits version 
works on both: 32 bits and 64 bits operating systems. To read “PRA.pdf” file you need PDF reader 
application available on your system. If you like to open PRA program automatically when you 
mouse click over “.pls” or “.wav” file, you have to associate those type of files with PRA program. 
To do so just click right mouse button over document file and from menu choose Open 
With→Choose Program... and then Browse... and select PRA program file. To make your 
association permanent check “Always use the selected program to open this kind of file” and 
confirm your choice.

For users who likes typical Windows installation procedure we also provide PRA installer.

Contact

Should you have any questions, comments or suggestions regarding PRA please e-mail

marek.dolleiser@sydney.edu.au

New version of the PRA application (if any) can be found at 
http://www.physics.usyd.edu.au/~marek/pra/index.html

Hardware

PRA uses sound adaptor and signal source which can be selected from menu: Settings → Audio 
Interface. 

Additionally, you may also need to change audio interface settings in your Windows operating 
system by using Audio Control Panel which come with your audio interface or use Windows 
Recording Control. To access Recording Control use Settings → Control Panel from the main 
Windows menu and then choose Sound and Audio Devices controller. Alternatively you can click 
over loudspeaker icon with right mouse button and choose Adjust Audio Property. I usually use CD 
Player or Line In input. Pulses produced by most detectors are quite narrow and hardly can be 
sampled accurately by sound adaptor. To fix this problem I use a simple low-pass RC-filter at the 
input. This solution works well with Geiger counter and NaI scintillation detector. For gas 
proportional counter used to detect X-rays I build simple pre-amplifier using operational amplifier 
OPA129 mainly to match high output impedance of the detector to low input impedance of the 
audio input, and also to amplify the signal to the line level.

Histograms

The PRA application analyses data by making histograms of: Counting Rate, Interva  l, Pulse Width, 
and Pulse Height. Just a few statistical parameters are calculated by PRA. For more accurate and 
sophisticated calculations export your histograms to a good data analysis software. I use QtiPlot.
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File

The File menu contains following items:

1. Open – opens data previously saved to a file. Default extension of the file is “.pls”. You can 
also open “.wav” sound file and it will be immediately analysed using the current settings, 
the same way as if the signal is connected to the sound card input. This mode of data 
acquisition is only useful when you are adjusting trigger settings, because usually the “.wav”
file is very large compare to the “.pls” file. Advantage of using “.wav” file is that you can 
open the same file with different settings and compare the results of analysis. The “.wav” 
file can be recorded using InTune application. For recording stereo files use any good sound 
recording program as for example Audacity, and save it as Windows PCM format (.wav).

2. Load Data – opens data file without changing current audio settings, pulse shape, and 
regions of interest.

3. Obtain Pulse Shape from Sound File – uses existing sound file to determine pulse shape. 
It is an alternative to the Pulse Shape Acquisition method.

4. Save – saves all acquired data and settings to a file, which later can be opened by PRA.
5. Export Counting Rate vs Time – saves counting rate vs time histogram as a text file which

can be imported in other applications for further data analysis. The column separator is the 
“tab” symbol. Exported data depends on the Settings.

6. Export Counting Rate Histogram – as above but a different histogram.
7. Export Interval Histogram – as above.
8. Export Pulse Width Histogram – as above.
9. Export Pulse Height Histogram – as above.
10. Export Regions of Interest – saves as text file ROIs selected in the Pulse Height 

Histogram.
11. Export Coincident Pulses Height – saves as text file heights of simultaneous pulses from 

the left and the right channels.

12. Exit – quits the application, equivalent to closing the main window.

Action

The Action menu contains following items:

1. Start Data Acquisition (keyboard shortcut A) – starts data acquisition.
2. Stop Data Acquisition (keyboard shortcut S) – when you start data acquisition, all data 

previously acquired is discarded, so always save your data to the file after data acquisition 
stops. Data acquisition stops automatically if application reaches any of data acquisition 
limits (see Settings). This menu entry works also if data acquisition was started from Start 
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Pulse Shape Acquisition. In this case Edit Pulse Shape window will open with applied new 
pulse shape parameters.

3. Start Pulse Shape Acquisition – starts data acquisition with the goal to produce 
automatically averaged shape of pulse. You can use this option if you like to average many 
pulses. In this mode the program always uses baseline triggering and the pulse shape central 
point is a top of the pulse. When using this option and your pulse threshold is smaller than 
10 arb.u, a higher settings of the trigger threshold are automatically applied (10 arb.u. to 90 
arb.u.). Please, ensure that polarity of pulses are indicated correctly by the pulse threshold 
sign.

4. Sound On/Off (keyboard shortcut Space)– switches on and off playing in real time sound 
representing arriving pulses. Larger pulses are played with higher pitch. This implemented 
in PRA v7 feature, is primarily for visually impaired people, but also can be quite 
entertaining for others. It is absolutely possible to recognise many of the simple radioactive 
sources by listening to the sound. I can recognise 54Mn, 57Co, 60Co, 133Ba, 109Cd, and 137Cs 
using NaI detector.

View 

The View menu contains following items:

1. Counting Rate vs Time – opens the Counting Rate vs Time window.
2. Counting Rate Histogram – opens the Counting Rate Histogram window.
3. Interval Histogram – opens the Interval Histogram window.
4. Pulse Width Histogram – opens the Pulse Width Histogram window.
5. Pulse Height Histogram – opens the Pulse Height Histogram window.
6. Audio Input – opens the Audio Input window.

Settings 

The Settings menu contains following items:

1. Data Acquisition and Analysis – opens the Data Acquisition and Analysis window.
2. Calibration – opens the Calibration window.
3. Audio Interface – opens the Audio Interface Settings window.
4. Pulse Shape – opens the Pulse Shape Editor window.
5. Advanced Filter – opens the Advanced Pulse Filter window.

Help

The Help menu contains following item:

1. Help Topics – opens “PRA.pdf” help file. 
2. About – displays version and copyright information about the PRA application.
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Main

This windows shows simplified pulses (only width and height) on the time scale. The most 
important elements of the window are: the window's title which contains also opened file name (as 
all other histogram windows), the application's menu, the time scale which can be change by using 
the ↑ and ↓ keys on the keyboard (when the window is active), and the information bar which 
displays a total number of recorded pulses, a number of filtered pulses (which is affected by using 
Analysed data selection in the Data Acquisition and Analysis window), and the total data 
acquisition time.

Closing this windows quits the application.

Counting Rate vs Time

This window displays counting rate as a function of time. Graphically it looks like histogram but it 
is not. In histogram on horizontal axis (abscissa) are bins with values of measured variable and on 
vertical axis (ordinate) frequency (occurrence) of events (number of counts) in each bin. On this 
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display abscissa represents bins (steps) in time and ordinate shows frequency of pulses (counting 
rate).  Counting rate vs Time is very important when analysing decay of radioactive materials. In 
this case the Time step parameter should be set smaller than a radioactive isotope's half lifetime, but 
large enough to avoid bins with zero counts if possible. Information about selected bin (indicated by
the red colour) is displayed under the title bar.

Counting Rate Histogram

This histogram shows distribution of the data displayed in the Counting rate vs Time window. It is 
important to set proper parameters for its bin size and Time step in Counting rate vs Time to build 
histogram which best represents the data. PRA calculates minimum size of the bin in this histogram 
and bin size can be only multiplicity of this value. The displayed information is related to the 
selected bin (red colour) and the mean value and the standard deviation of the counting rate 
distribution.

Interval Histogram

This window displays histogram of time interval of pulses. If the S-fold parameter is set to one, it 
represents distribution of an interval between a two consecutive pulses. In this case if there is not 
dead time present (which is not true in any real case at least because of a finite pulse width) and 
average counting rate is constant, the histogram should be of an exponential decay shape. The 
biggest value should be in the first bin. For real data usually we observe fewer pulses in a few first 
bins than expected. PRA uses interval distribution to calculate the dead time of the data acquisition 
system. The displayed information is related to the selected bin indicated by the red colour. Also, if 
S-fold equals to one, the approximate value of the dead time is displayed.
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Pulse Width Histogram

This window shows histogram of pulse width. Pulse width is recognised in PRA during data 
acquisition as period from a first sample when voltage exceeds the threshold to the first sample 
when voltage drops below the threshold. With such definition the pulse width depends on all 
parameters for pulse triggering. Even if it does not tell much about real pulse width (especially if 
pulse passes by low pass filter on the input of the audio adapter), it can be still useful. When the 
Shape tolerance method option is enabled, a pulse width is also affected by the shape threshold 
value (listed under Shape tolerance method check box) and usually leads to a very short values of 
the pulse width, which has no expected physical meaning of the pulse width. In such a case pulse 
width is a good indication of time period when left and right channel pulses are considered to be in 
coincidence. The displayed information is about selected bin indicated by the red colour.

Pulse Height Histogram

This window displays pulse height histogram. For many detectors pulse height is proportional to 
energy deposited in the detector1 by elementary particle such as electron, proton, alpha etc. For this 
reason it is very useful to produce spectra of radioactive sources. Pulse height is recognised by PRA
during data acquisition. The triggering method and triggering parameters can be set in the Settings 
window. The pulse height is measured in arbitrary units (100 arb.u corresponds to the maximum 
value which an audio adapter can sample) and it needs calibration before using it as multi channel 
analyser. The displayed information is about selected bin indicated by the red colour.

User can also define up to 16 'Regions Of Interest' (ROI) in each channel. To do this place a current 
bin where you like ROI to start and then press key B. Next move current bin to position where you 
like ROI to end and then press key E. Alternatively you can select ROI with the mouse. Depress 
Ctrl key and then click and hold left mouse button at position which you like ROI to begin, drag the
cursor where ROI should end and release mouse button. If a new ROI overlaps any existing ROI(s),
the last one is automatically deleted. You can also delete ROI by selecting current bin inside an ROI

1 The height of pulse from detector depends, but is not function of energy of detected particle. For example 662 keV 
photons from 137Cs source can produce wide distribution of pulses including Gaussian shaped photo-peak and large 
Compton effect part.
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and pressing Delete key. If you try to mark more than 16 ROIs, the first marked ROI will be 
automatically replaced by the new one. When current bin is inside ROI, additional information 
about mean value, standard deviation, gross number of counts, and net number of counts in the ROI 
is displayed under the title bar. This can be useful to obtain more accurate parameters of selected 
peak (or deep). Parameters are calculated using standard statistical analysis on the net counts. Net 
counts are obtained by subtracting a background from the peak. The background is estimated as a 
straight line connecting first and last sample in ROI. 

From version 4.2 ROIs are saved in the settings file and from version 5.0 also in the data file. 

You can export all ROIs as a text file by using Export Regions of Interest from the File menu.

If Show Gaussian correlation check box in Data Acquisition and Analysis dialogue is checked, then
also 'Gaussian correlation' (actually it is correlation between normalised discrete Gaussian function 
in range (-2σ, 2σ) and pulse height histogram) is calculated and displayed at pulse height histogram 
window. This is a new feature of PRA version 8.0. Most of nuclear detectors exhibits very simple 
dependence of standard deviation (the spread) of the peak and its mean value. The standard 
deviation is proportional to square root of the mean. Figures below shows pulse height histograms 
respectively for small and large number of counts. If current bin is at position where Gaussian 
correlation value is larger than zero, then you can quickly select ROI by pressing D, F, G, or H key 
(each one selects different width of the ROI around the peak).

 

In both cases 'Gaussian correlation' curve (red colour) is quite smooth even so the first histogram is 
build with many times smaller number of counts than the second one. You can use positions of local
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maxima of those curves to approximate quite accurately mean values of histogram peaks without 
using ROI (or to find which part of histogram should be selected).

Audio Input

This window shows signal at the inputs of the audio interface. Red and blue lines shows left and 
right channels respectively. Yellow and green horizontal lines correspond to the trigger levels. Full 
height of the display corresponds to the full range of ADC of your sound interface. The picture 
shows the same signal from NaI detector applied to both left and right channels. Left channel is 
connected through a low pass filter. The channels are set to different gain to achieve approximately 
the same pulse height in both. Results of this experiment when using 60Co source shows slightly 
improvement in resolution (≈0.03%) but a huge improvement (≈100 %) in number of accepted 
pulses when using low pass filter. Pulse trigger and shape tolerance settings in both channels were 
identical.
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Data Acquisition and Analysis

Important: Controls in this dialogue box whose names are in static frame are only important 
during data acquisition. Changing their values after collecting the data have no influence on 
analysed data. Their values should be set before starting data acquisition. However, for testing only 
they can be changed during data acquisition without stopping the action. In such a case the resulted 
data can luck of consistency.
The Data Acquisition and Analysis window is divided in 8 groups:

1. Pulse recognition – you can choose one of two different pulse recognition methods based 
on a shape analysis or on an absolute value. When the Use shape tolerance method is 
selected, all eight parameters in this group are important. In this case the application 
calculates pulse height as a value of cross-correlation function (the sum of products) of 
sampled values and values defined by the pulse shape. If it exceeds the Height threshold 
value then the current pulse shape and defined pulse shape are compared by means of the 
sum of squares of differences between the two shapes. If the sum of differences is smaller 
than the Tolerance threshold value, a pulse is counted. The value of the shape tolerance 
should be set between 0 and 100. The value of 0 corresponds to the shape of the current 
pulse to be identical with the predefined one. The value of 100 corresponds to very bad 
correlation between the current pulse and predefined shape. Proper settings of the shape 
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tolerance value depends on the defined pulse shape, but the value of 10 as the starting point 
is a good choice. To obtain very good pulse height resolution the value of tolerance should 
be very small, say 0.2. Unfortunately this small tolerance value filters out a lot of the pulses.
Version 9 of PRA try to solve this problem by introducing correction parameters which 
corrects pulse height according to the accuracy of the pulse shape. By using these 
parameters one can obtain almost the same good resolution using threshold of 10 as with 
threshold 0.1 without correction. It gives boost to the number of counts especially at lower 
pulse heights (lower energy) were pulses are rejected frequently because of small signal to 
noise ratio. I found that correction parameters in range 50 to 100 are giving the best results, 
but certainly it depends on the pulse shape and should be optimised in every case. Version 
10 of PRA let you collect the data with high value of the tolerance threshold where most of 
the pulses are accepted and then use “Advanced Pulse Filter” to select required range later. 
If you do not like pulse height correction, set it to 0.
If the Use shape tolerance method is not checked, only pulse height threshold parameters 
are taken into account to trigger the pulse. In this case the value of the baseline is calculated 
over large number of samples and a difference between top of the pulse and the baseline 
becomes a pulse height. 
The sign of the threshold decides about polarity of triggered pulses: plus for positive and 
minus for negative. As an example, a typical pulse shape taken from the gas proportional 
counter is shown below. The shape is mostly dependent on the pre-amplifier. To produce 
quickly pulse shape you can use Action → Start Pulse Shape Acquisition command.
New in version 11 are Boost gain parameters. Their values can be set in range 1 to 100. It is 
additional adjustment of the sound interface gain which does not change the gain set in the 
sound recording control panel. This feature can be useful if the observed pulses are smaller 
than 10 arb.u. and the gain control is already set to maximum. Also, fine adjustment of the 
gain in the left and the right channel can be handy.

2. Data acquisition limits – you can set maximum value for acquisition time or number of 
pulses. If your data acquisition process exceeds any of those limits it will stop immediately.

3. Analysed data selection – you can set beginning and duration of the data that you like to 
select for analysis. It is usually good practise to start data acquisition earlier than some 
interesting event is going to happen (for example sudden increase in counting rate) and after 
stopping data acquisition select only interesting section of the acquired data. Also, you can 
select the audio channel from which histograms are build and displayed. For example, if you
like to see only those pulses from the left channel which occurs at the same time as another 
pulse in the right channel (time coincidence), choose Left if Right. Advanced events filtering 
including pulse height, pulse distortion, and pulse width is possible by checking “Use 
advanced filter” check box and editing entries in “Advanced Pulse Filter” dialogue box 
window.

4. Counting rate vs Time – there is only one parameter which you can change: the time 
period that you used to calculate counting rate. There is also check box which you can use to
display statistics in logarithmic scale.

5. Counting rate histogram – as for all other following histograms there is Bin size parameter
and Show in logarithmic scale check box which you can edit.
This histogram uses the Counting rate vs Time data and it is affected by its Time step 
parameter. For radioactive source which does not change its intensity, the counting rate can 
be described as Gaussian or Poisson distribution, depending on chosen bin size and intensity
of the source.

6. Interval histogram – you can change additionally S-fold parameter. If S-fold parameter is 
one then interval between every two consecutive pulses is counted, if it is two, then interval 
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between every first and third pulse is counted etc. Possibly the smallest bin size is selected 
automatically after opening “.pls” or “.wav” file and after starting data acquisition with a 
new sampling rate.

7. Pulse width histogram – you can change two settings as with other histograms. The bin 
size is set automatically the same way as for Interval histogram. If you are using pulse shape
analysis the width of the pulse is very short (usually one or two sampling periods) and it 
does not correspond to the real pulse's width.

8. Pulse height histogram – the settings are identical as for Pulse width histogram but pulse 
height is analysed rather than pulse width. Additionally, there are two check boxes: Use 
energy calibration and Show Gaussian correlation. If the Use energy calibration check box 
is checked the Pulse height histogram uses parameters from Energy Calibration dialogue 
box where you can specify parameters for the left and the right audio channel. This check 
box also is affecting data which is exported using Export Pulse Height Histogram menu. If 
Show Gaussian correlation check box is checked, then the result correlation curve of 
predicted Gaussian distribution and pulse height histogram is also shown in the PulseHeight
Histogram window.

The Apply button applies settings and the Save button applies settings and saves them as default in 
the “PRA.ini” file. The Save As button let you save PRA settings under a different name. This file 
can be later loaded by using the Load button. From version 4.2 settings files contains also ROIs, 
from version 5.0 also audio settings, and from version 6.0 calibration data points and comments. 
This can sometimes produce a problem if your audio device has been changed. In such a case just 
delete a “PRA.ini” file and start the program again.

Audio Interface Settings

Use this dialogue box to select audio device and its parameters for data acquisition and playback. 
Higher sampling rates at input are preferred for better hight pulse resolution and higher counting 
rates. If your sound device does not truly support higher sampling rates, do not use this option2.  It 
is interesting that some settings are not supported as expected from hardware specification. For 
example, when I tried my “E-MU 0204” interface, it supported well all options when bits per 
2  Windows drivers sometimes artificially support higher sampling rate by interpolating additional samples.
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sample was set to 16, but only stereo mode was working for 24 bits and 32 bits. For output I 
recommend to use 48000 sampling rate and preferably on different output device to avoid sound 
distortion, when your hardware is not able to play smoothly. Popular sound interfaces build in 
motherboard perform well with both input and output set to 48000 samples per second.

Pulse Shape Editor

The Edit Pulse Shape window allows editing shape of the pulse which can be used to analyse the 
waveform. For each channel there are 16 consecutive sample values of which at least two different 
values should be enabled. To copy or paste all data in one channel use Copy or Paste buttons. 
Pasted data is limited to 116 matrix if clipboard contains more columns or rows. The values are 
automatically normalised3 when you click over the OK button.  The current pulse shape is saved in 
“PRA.ini” file by means of the Save (or Save As) command from the Data Acquisition and Analysis 
window and will be automatically loaded next time you open the application. From version 5.0 of 
PRA also data file “.pls” includes pulse shape and it becomes current pulse shape when you open 
previously saved file. The Cancel button discards all changes and sets the last accepted values.
Pulse shape shown at the above image was taken from my NaI detector with left channel connected 
through low pass filter and right channel straight to the audio input. Comparing first five samples in 
each channel shape one can notice small oscillations4 in the right channel are almost totally 
suppressed in the left channel.

3  The mean value of the data points to be 0 and sum of its squares to be a difference between maximum and 
minimum value of the data points.

4 Those oscillations are introduced by digital anti-aliasing filter in the audio interface to remove frequencies above 
half of the sampling rate (Nyquist frequency)
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The pulse shape presented by the above image was constructed by averaging a few pulses from the 
waveform recorded with the InTune application. One can use Action → Start Pulse Shape 
Acquisition menu to achieve similar effect. The shape can be easy set to look for leading or falling 
edge of the pulse. The purpose of the pulse shape analysis is to increase spectrum resolution by 
rejecting badly formed pulses (as it is in a case with partially overlapping pulses) from statistics. 
Also, the noise (usually masking a low amplitude pulses) can be significantly reduced.

Calibration

In this dialogue box you can specify up to eight calibration data points for each channel. Clear 
buttons sets all values in corresponding channel to zero. To copy or paste all data in one channel use
Copy or Paste buttons. When you copy, data on the clipboard is in text form which consist three tab 
separated columns. Paste function works with clipboard containing text with column separated by 
tabs, spaces, and semicolons. Number of columns and rows pasted from the clipboard is limited to 
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38 matrix. Also, you can choose calibration mode from Fit slope, Fit linear, and Interpolate 
options. The popular and recommended for most of the detectors is a linear fit. Similar to linear is 
slope fit, where calibration line is forced to go through (0,0) point. This can be useful for example if
you calibrate your system using source which has only peaks at higher energy and no low energy 
peaks are available. From version 8, PRA uses also standard deviation of calibration peaks (column 
SD) for weighting calibration points and for Gaussian correlation parameters. Interpolate option is 
for calibrating detector systems where energy versus pulse height dependence is non linear. PRA 
uses simple linear interpolation between calibration points. Energy beyond last calibration point is 
extrapolated from the two largest data. If you have just one calibration point, all three method gives 
you the same result. Text edit box Energy Units lets you to assign a different name (maximum 6 
characters) for units which you are using. When you click over Apply button, all entries are checked
for consistency5 and accepted values are propagated to the pulse height histogram.

Advanced Pulse Filter

This dialogue box provides PRA users with opportunities to select additional parameters of the 
pulses which can be used to produce all histograms. This is filter which does not change any 
information contained in *.pls file. Especially selecting ranges of pulse width and pulse distortion 
can be useful to find proper values for “Tolerance correction” to increase resolution of the pulse 
height histogram. This filter when used during data acquisition affects also 'played' pulses.

5 All three values in any row can be simultaneously zeroes or non-zeroes and larger pulse hight must correspond 
larger energy. At least one row for each channel must contain non-zeroes data.

Page 17



Mathematics in PRA
Mathematics in PRA...........................................................................................................................18

Pulse Recognition..........................................................................................................................18
Base line method.......................................................................................................................18
Pulse shape method...................................................................................................................19

Energy Calibration.........................................................................................................................20
Fit slope.....................................................................................................................................21
Fit linear....................................................................................................................................21
Interpolation..............................................................................................................................21

Dead time calculations...................................................................................................................22
Region Of Interest statistics...........................................................................................................22
Gaussian correlation filter..............................................................................................................23
Tolerance correction.......................................................................................................................25

In this chapter I would like to show6 mathematical formulas working behind the scenes in PRA. 
Some of them are commonly well known and some are designed by myself specifically for use in 
PRA. I think this could be useful for PRA users to better understand how the program works and for
programmers to use similar solutions in their own software.

Pulse Recognition

Base line method

There are two methods implemented in PRA to recognise and analyse pulses. The first method is 
standard. First we are looking for the base line of the input signal. In PRA the base line is calculated
as an average of all samples in a buffer (usually few hundred samples) which are smaller than zero 
(assuming that the pulses are positive).

base=
∑
i=1

i=max

y i⋅εi

∑
i=1

i=max

εi

where:

max  is the number of samples in buffer,

y i is value of ith sample,

εi equals to 1 if y i<0 and 0 otherwise.

Then PRA checks if y i−base exceeds the pulse threshold, if so, corresponding i is marked as 
beginning of the pulse. Now PRA is looking for the maximum value of y i−base until it becomes
smaller than the pulse threshold. Then the corresponding i become the end of the pulse and the 
maximum value of y i−base its height.  
This method of pulse recognition is simple, fast, and it works fine for pulse counting, when good 

6 It could be pleasure and challenge for students and other mathematically minded PRA users to proof some of those 
formulas.

Page 18



pulse height resolution is not important (Geiger-Müller counter). Poor pulse height resolution is the 
result of changes in the base line value and the fact that only one sample decides about pulse height.

Pulse shape method

The second method of pulse analysis was designed to achieve the best possible pulse height 
resolution. I call it a 'pulse shape method'. This method relies on comparison of a specially prepared
'standard pulse shape function' with small part of consecutive signal samples. The comparison is a 
simple dot multiplication of standard pulse shape vector and signal samples. PRA uses up to 16 
points long7 discrete standard pulse shape function, which can be edited by hand or obtained 
automatically from the signal input. By editing pulse shape by hand the user can achieve similar 
effects of pulse recognition as in the previous (base line subtracting) method or commonly used in 
commercial MCAs pulse integration method. However, the most powerful is the procedure where 
pulse shape representation is obtained automatically from the signal. In this case PRA is looking for
local maxima in input samples and saves it together with 8 samples before maximum and 7 samples
after. All those samples are averaged and then 'normalised' to make useful standard pulse shape 
representation. In PRA normalisation is a linear function applied to the pulse shape to achieve two 
special properties:

1. Sum of all 16 pulse shape numbers must be equal to zero. This is done by simple subtracting
the average. This feature of pulse shape function makes result of dot product not dependant 
of any constant shift of the signal base line.

2. The length of pulse shape vector (sum of squares of all pulse shape values) must be equal to 
the difference between its maximum and minimum components8. This makes pulse height to
be of similar value as pulse height obtained using base line method.

In a more formal mathematical way this can be represented by formulas: 

s=
∑
k=0

k=15

sk

16

 

S k=
(sk−s)⋅h

∑
k=0

k=15

(sk−s)2  

where: 

sk is k th value of pulse shape before normalisation,

S k is k th value of pulse shape after normalisation,

h is a difference between maximum and minimum value of pulse shape (the height of pulse 

shape itself). Reader can check that after this normalisation procedure h=∑
k =0

k=15

S k
2 become 

invariant under normalisation (it does not change after next normalisation) and is equal to the 
difference between maximum and minimum components of the standard pulse shape vector.

7 The number 16 is arbitrary and chosen to achieve good pulse height resolution and relatively small calculation load.
8 Usually vectors are normalised to one.
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Now we can use our pulse shape to find dot product of our standard pulse shape and vector 
consisting of 16 consecutive samples:

hi=∑
k=0

k =15

y i+k⋅S k

where:

i is a running index along samples in the input buffer,

hi is a dot product of standard pulse shape vector and 16 consecutive samples vector.

PRA uses hi as a new value of the sample and is looking if it is larger than pulse threshold to 
mark beginning of a pulse and then identify pulse height and pulse width the same way as in the 
base line method (base=0).

Pulse height calculated using pulse shape method is more accurate than when using base line 
method, but still it can count pulses which shape is quite distorted. To rectify this problem PRA uses
pulse shape filter to count only those pulses whose shape is similar enough to the standard pulse 
shape. The procedure is very simple. Each time when hi has been found to exceed pulse threshold
PRA normalises 16 samples starting from y i the same way as standard pulse shape. Then this 16 
samples are subtracted from the standard shape, each difference squared and added together. The 
result is a good measure how both, standard and current pulse shapes are similar. When it is zero, 
the shapes are identical. If this value is larger than the pulse shape tolerance threshold, the pulse is 
rejected. 

t i=∑
k=0

k =15

(Y i+k−Sk )
2

where:

Y i+k is normalised 16 consecutive samples vector (starting from the ith sample),

t i 'tolerance' is a measure of the difference between the current samples and the standard shapes.

Energy Calibration

Signal samples from sound adapter which are analysed by PRA usually comes as signed 16 bits, 24 
bits, and 32 bits. PRA converts all of them to real number from (-100, +100) interval. Those 
numbers do not have any physical units (they are proportional to the input voltage) and PRA uses 
for them so called arbitrary units (arb.u.). Pulse height is also expressed in arbitrary units. The 
height of pulse coming from detector usually depends on energy deposited by elementary particle 
inside the detector. This dependence is not very strict and for certain energy deposited in detector 
there is possible the whole range of output pulse heights which produce a peak in pulse height 
histogram. The shape of this peak can be described by so called normal or Gaussian distribution. By
calibration we understand dependence of the mean value of this peak and corresponding energy 
deposited in the detector (which very often is a full kinetic energy of the detected particle). For 
example well known source Cs137 produces gammas with energy of 662 keV. If this gamma 
interacts with detector by photoelectric effect all its energy is passing to an electron and if size of 
detector is large enough there is big chance of whole 662 keV energy to be deposited in the detector.
Pulses corresponding to this event will form Gaussian peak on pulse height histogram. If mean 
value of this peak is say 20 arb.u. then our calibration function will assign 662 keV to 20 arb.u. and 
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PRA will display abscissa on pulse height histogram in keV rather than arbitrary units. PRA uses 
three methods of calibration. 

Fit slope

This is the simplest (and very good) method to calibrate the detector. Most of the detectors shows 
quite good proportionality between energy deposited in the detector and pulse height. In this case 
function y=a x will be a good choice. PRA uses weighted least squares method to find parameter
a. From Energy Calibration dialogue box we have up to 8 calibration entries for each channel:
(Mean of the peak in arbitrary units, Standard Deviation SD in arbitrary units, Energy in energy 
units).

Let's name it as (x i ,σ i , y i) . 

Using least squares method we can find

a=

∑
i

x i y i

σ i
2

∑
i

x i
2

σ i
2

where i is running over all (non zero) calibration data points.

Fit linear

In this case fitting function is linear: y = a x + b. This is more general form than fitting slope and 
should be used if you know well some low energy calibration points.

The parameters a and b are calculated using formulas:

a=

∑
i

xi

σi
2 ∑

i

yi

σ i
2 −∑

i

x i y i

σ i
2 ∑

i

1
σ i

2

(∑
i

x i

σ i
2 )

2

−∑
i

x i
2

σ i
2 ∑

i

1
σi

2

 

b=

∑
i

x i

σ i
2 ∑

i

xi y i

σi
2 −∑

i

xi
2

σi
2 ∑

i

yi

σ i
2

(∑
i

x i

σ i
2 )

2

−∑
i

x i
2

σ i
2 ∑

i

1

σ i
2

Interpolation

This calibration method should be used if your detector is not linear e.g. calibration function slope 
is changing from low energies to high energies. In this case PRA uses simple linear interpolation 
between calibration data points including point (0,0) at the beginning and extrapolating last pair of 
calibration data points for higher energies. Linear interpolation for x lying between two calibration 

data points x i≤ x≤x i+1 can be expressed as: y=
yi+1− y i

xi+1− xi

x+
x i+1 y i− xi y i+1

x i +1−x i
.
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Dead time calculations

Dead time is unavoidable property of any detector and data acquisition system. By dead time we 
understand as minimum time between two consecutive pulses to be recognised by data acquisition 
system separately. Dead time of the system can be affected by detector itself (as recovery time in 
GM counter, scintillation time in NaI crystal or plastic scintillator), analogue electronics (amplifiers,
filters, and shaping devices), and digital electronics (including ADC, data storage time etc.).

In case of our “PRA” program, the main constrain for dead time is width of pulse which can’t be 
too small to be properly sampled by the computer’s sound card. PRA uses time interval statistics to 
find dead time of the system. Manifestation of dead time phenomenon in time interval histogram are
empty and less populated than expected bins at the beginning. If counting rate is constant, we are 
expecting that distribution of time interval will follow exponential decay curve with maximum at 
first bin. In reality exponential decay curve is quite well approximating histogram only for higher 
bins. How PRA is analysing this histogram to find a dead time of the apparatus?

1. We are looking for bin with maximum number of counts. Let's name corresponding time 
interval T.

2. Next we are counting all events in regions [0,T ) , [T , 2T ) ,  and [ 2T , 3T ) . Let's call 
them s0, s1,  and s2 correspondingly.

3. Now we can calculate dead time W using formula:

W ≈ (1−
s0 s2

s1
2 )T

Region Of Interest statistics

Region Of Interest (ROI) is any range of consecutive bins in pulse height histogram. Usually we use
it to select a peak corresponding to detector response to mono-energetic particles. The most 
interesting parameters calculated by PRA are: mean value, standard deviation, gross number of 
counts, and net numbers of counts. Gross number of counts in ROI is just a sum of all counts in 
selected region. Usually peak is not located simply with base at zero, but is sitting on the top what 
we call a background (not necessary coming from a background radiation). By background we 
understand slowly changing profile of the histogram. Net number of counts is calculated by 
subtracting background counts from gross counts. PRA assumes that background under the peak is 
changing linearly. To calculate this line's parameters firstly we take a few (10% of the with of ROI) 
samples around beginning and calculate their average value and do the same at the end of ROI. 
Next we subtract the area of the trapezoid build on those new points from a gross number of counts 
to get net number of counts. Mean value and standard deviation are calculated using net counts 
which are more meaningful that the raw counts. More precisely we can describe the whole process 
using formulas:

Gross=∑
i=Rb

i=R e

ci

ab=

∑
i=Rb−0.1 (Re−Rb)

i=Rb+0.1( Re−Rb)

ci

0.2(Re−Rb)+1
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ae=

∑
i=Re−0.1 (Re−R b)

i=Re+0.1 (Re−Rb)

c i

0.2(Re−Rb)+1

Net=Gross−
(ab+ae)(R e−Rb+1)

2

n i=c i−(ab+
(i−Rb)(ae−ab)

Re−Rb

)

Mean=∑
i=Rb

i=Re ni

Net
i

σ=SD=√∑i=Rb

i=Re ni

Net
(i−Mean)

2

 for Net≠0  

where:

Rb is the beginning bin of ROI

Re is the end bin of ROI

c i is a number of counts in the ith bin

n i is a net number of counts in the ith bin

σ is a standard deviation of the peak in the ROI

Gaussian correlation filter

In many cases the only purpose of pulse height histogram is to find characteristic photoelectric 
peaks which can help to identify radioactive isotopes in your source. The best method is to collect 
data for such long time that pulse height histogram becomes a very smooth curve and all peaks 
become clearly visible. The problem using this method is obvious; usually you have to collect your 
data for very long time. This produce another problem as long term stability and temperature 
dependency of your detector. Some people try to solve this problem by smoothing data using simple
averaging consecutive bins. Although it can sometimes help to see peaks which can be hidden under
normal statistical data fluctuation, but usually it also leads to identification of false peaks and 
smears the data. This method is equivalent to just larger bin size. New method used by PRA version
8 is filtration of the pulse height histogram data in more scientific way. Most of the detectors are 
working according to simple principle; number of detectable particles produced in the detector is 
proportional to kinetic energy of primary particle which enters detector. In case of scintillation 
detectors it will be number of photons produced during scintillation, in case of gas proportional 
counter it will be number of positive ions and electrons or in case of semiconductor number of 
electron-hole pairs. Transducer attached to the detector (photomultiplier, thin wire anode or 
electrode) produce signal which is proportional to the number of detectable particles. This number 
undergoes certain statistical fluctuation which can be described as Poisson distribution. This is 
distribution which has a very simple and useful property; its standard deviation is a square root of 
the mean value. We will use this property to identify the peaks in our pulse height histogram. If 
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number of detected particles in one pulse is large, then Poisson distribution can be simply replaced 
with a normal (Gaussian) distribution which is more convenient for calculations. We still assume 
that peak standard deviation is proportional to the square root of the mean value (mean bin of the 
peak or energy of detected particle). PRA does all calculations automatically in real time, you have 
just to tell what is standard deviation for peaks that you use for calibration (this is the main reason 
of the new column in the calibration dialogue box). For filtering peaks PRA uses similar technique 
as for filtering pulses from the sound signal, it performs just dot product operation of pulse height 
histogram data and especially normalised Gaussian shape.9 We use discrete Gaussian shape in range
(−2σ ,2σ)  which covers 95% of the peak. Gaussian shape is normalised this way that the sum 

of all its values is zero (subtracted average value) and sum of all squares of the (new) values is one. 
Because of this normalisation and the fact that Gaussian is symmetrical in respect to the mean (in 
our shape case 0), the dot product does not depend on data shift up or down as well as when peak is 
lying on the slop or not. This makes our operation result not sensitive to the background counts. The
dot product of Gaussian shape (with standard deviation dependent on the bin number) is performed 
along all data in the pulse height histogram. The result is called here Gaussian correlation and its 
value is printed on the same pulse height histogram display as red colour points. All negative values
of the Gaussian correlation are plotted as zero. Gaussian correlation curve is usually very smooth 
even with not so large number of counts in the histogram bins and its local maximum quite 
accurately indicate mean values of the peak. PRA uses scaling to display Gaussian correlation curve
to be well visible together with pulse height histogram data.10 You can use page up and page down 
keys to change vertical scale or just use logarithmic scale for your convenience to make the 
Gaussian curve better visible. PRA uses standard deviation which is calculated from all non zero SD
values in the calibration dialogue box. The distance between points where Gaussian correlation 
curve under the peak crosses zero is approximately equals to 2.6 standard deviations (a little larger 
than FWHM). All this can be more precisely described using mathematical formulas:

for k∈(−2σi , 2σi) Gs k=exp (
−k 2

2σi
2 )  

Gsk=Gsk−Gs

Gsk=
Gs k

∑Gs k
2

Gci= ∑
k=−2σ

k=2σ

ci+k Gs k

where:

σi is an expected standard deviation of the peak with mean value at ith bin,

Gsk is the k th element in Gaussian shape,

Gci is the ith element of the Gaussian correlation curve,

c i is number of counts in the ith pulse height histogram bin.

9 This operation can be also named as calculating discrete correlation of the histogram and Gaussian filter.
10 If standard deviation is chosen properly, then Gaussian correlation value at the centre of the peak should be in range 

(or slightly below) of the number of counts (subtracting the background). However, it is no crucial to use the right 
value of the standard deviation. If SD is to small, then Gaussian correlation curve shows more irregularities. This 
can be even beneficial to recognise two close peaks.
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Tolerance correction

Many PRA users have problem how to find and use “Tolerance correction” parameter. To rectify the
problem I will shortly show how to do it in PRA version 10 using “Advanced pulse filter”.

1. After establishing pulse shape, I started recording pulses from NaI detector using Cs-137 
source. By looking at “Counting Rate vs Time” I found that setting 10 for “Tolerance 
threshold” does not change counting rate. I recorded 10000000 pulses. Pulse height 
histogram without using any filter or correction is shown below. My NaI detector has 
around 10% resolution.

2. Then I used to select ranges of pulse distortion: 0 to 0.2, 0.2 to 0.4, 0.4 to 0.6, etc. 
“Advanced Pulse Filter” for range 0.2 to 0.4 is shown below.

3. For each of the selected distortion range I read “Mean” and “Gross” values of the 662 keV 
photo-peak and make a scatter graphs using QtiPlot (just advertising good program, you can
use MS Excel, LibreOffice Calc, Gnumeric or similar).
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4. As one can see, peak's mean value is changing approximately linearly, except a small 
discontinuity around pulse distortion at 5.

5. Similar behaviour represents number of filtered pulses. The sudden change in number of 
counts at distortion = 5 is due to different pulse width. Most of the events are of width = 1, 
but small amount have width = 2.
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6. When I selected only events with pulse width = 1, I had this plots for mean and number of 
counts.

7. This time I used bin size 0.5 just to save time.
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8. Number of counts drops to zero above distortion = 4.

9. From linear fit to mean vs distortion plot, I found tolerance correction by using equation: 
tolerance correction = -A*10000/B = 78.46. The factor 10000 comes from increasing both: 
pulse distortion (tolerance) and tolerance correction 100 times.

10. As we can see standard deviation of the peak is improved from 3.417 to 3.353, but we lost 
some counts; 544702 vs 401727. This lost of pulses was painful for me and I went back to 
the full range of pulse width and fit straight line to the mean vs distortion graph despite 
discontinuity.
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11. Correction factor calculated from this data comes as 0.495*10000/75.460 = 65.60. After 
applying this tolerance correction (without any additional pulse filtering), I saw the result.

12. As you can see standard deviation is even smaller than with pulse width filter (3.339 vs 
3.353) and the gross number of counts in the peak is almost the same as without any 
correction (543923 vs 544702). The small difference in number of counts in the peak comes
just from more narrow peak (see Gaussian correlation).
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Keyboard Shortcuts

PRA uses following commands which can be accessed by keyboard shortcut: 

1. → (right arrow) – increase current position in an active histogram by one. 
2. ← (left arrow) – decrease current position in an active histogram by one. 
3. ↑ (up arrow) – horizontal zoom out. 
4. ↓ (down arrow) – horizontal zoom in. 
5. Page Up – vertical zoom in. Can be also done with the Mouse Wheel rotation.
6. Page Down – vertical zoom out. 
7. A – start data acquisition. 
8. S – stop data acquisition.
9. Space – Start or stop 'playing' pulses.
10. . (period) – Rises the pitch of the played sound.
11. > – Increases the rate of the “played pulses”.
12. , (comma) – Falls the pitch of the played sound.
13. < – Decreases the rate of the “played pulses”.
14. B – mark beginning of 'Region Of Interest' in Pulse Height Histogram. 
15. E – mark end of 'Region Of Interest'.
16. K – mark all ROIs in the right channel identical to the left channel ROIs.
17. D – mark automatically very wide ROI around Gaussian correlation peak (D for double).
18. F – mark automatically wide ROI around Gaussian correlation peak (F for full).
19. G – mark automatically medium ROI around Gaussian correlation peak (G for Gaussian).
20. H – mark automatically narrow ROI around Gaussian correlation peak (H for half).
21. Delete – deletes ROI at current position in pulse height histogram.
22. Delete + Shift – deletes all ROIs in pulse height histogram.
23. Q – opens Information dialogue box which displays the same information as in active 

window as text which can be read by “JAWS” program. To quit this dialogue box press 
Enter key.

24. F1 – Activates all “Save” menu items during data acquisition without stopping. This status 
will be reset to 'normal' when you restart data acquisition.
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File Structures

All files exported from PRA are in tab separated text format (ASCII).
Other files are in binary formats as follows:

Main data file *.pls starts from the header:
typedef struct PlsHeader {
         unsigned long PulseTag; //"Puls" 

unsigned long NumberOfPulses[2]; 
long long AcquisitionTime; //numberOfTimeFrames 
SETTINGS AllSettings; //4096 bytes 

}PLSHEADER; //4112 bytes

following by 'numberOfPulses' pulses:

typedef struct Pulse {
   long long Begin;

unsigned long Width; 
unsigned long Height;

 unsigned long Distortion;
 unsigned long Coincidence;
  }PULSE; //24 bytes

Settings file (*.ini):

typedef struct Settings {
AUDIOSETTINGS CurAudioSettings;//2*16 bytes
double SettingsData[18];//18*8 bytes
char CheckBox[9];//9 bytes
char CoincidenceMode;//1 byte
char FilterCheckBox[3];//3bytes
char Comment[1315];//1315 bytes
double Filter[2][16];//32*8 bytes
double PulseShape[2][16];//32*8 bytes
char ShapeCheckBox[2][16];//32 bytes
double CalibrationData[2][8][3];//2*8*3*8 bytes
char EnergyUnits[31];//31 bytes
char CalibrationMode;//1 byte
ROI Roi[2][16];//32*56 bytes

}SETTINGS;//4096 bytes
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